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Upcoming Events

We havepassed the winters solctice. The days are getting longer, although the weather is
getting colder. We have had the interclub competition with Edwardstown, where wetrumped
themby 1 pointin the colour prints. In the rest ofthe competition we had the same result as
previous years. The club competitions,“someone elses Art” and “Detail” have been ener-
getic with some sxcellent images and there is a samplepresented in the photogallery on page
2.

This month we have an articleon photographing the sun. This follows the transit ofvenus
and reflects a conversation I had with P eter Maunder a club member who has had some ex-
perience with the South Australian Astronomy club. You can see that the banner this month
porttrays theshadow ofvenus as it moves across the visage ofthe sun. This image was taken
using apair ofbird watching binoculars. It has quite a degreeofchromatic aberration. This
prompted me to do a little research on this phenomenon, and you can find an article on page 4.

My father in his retirement has enjoyed attending a philosophy discussion group at the Uni-
versity of Adelaide. Each week the members present a topic ofinterest. I was intrigued to
hear that the topic for discussion last month was Aesthetics and the philosophy ofphotogra-
phy. After a discussion with my father, | have made a one page summary ofthe main argu-
ments that were discussed in a shott article on page6. Ilooked long and hard for a catchy
quote from Immanuel Kant, but unfortunately his writing is so dense and convoluted it is best
left for philosophers to read. Ifany one has studied this field, I would beinterested to hear
their views on the philosophy ofphotography. I have only touched the surface ofthis subject.
I’msure much more could be said about the ethics ofphotography. Pethaps a topic for an-

other discussion.

Lastly I have produced an article on squaring up or rectifying animage in photoshop. This
technique was mentioned briefly by Jeremy Watson as a possibleworkshop idea. I haveout-
lined my technique in the hope that it might be helpful. I find itparticularly useful when I am
photographing art work. It allows me to stand to one side ofa painting to reduce reflection
from the flash, but then reconfigure the art work without thedistortion created by the point of
view / pesspective. | had hopedto have an article about offcamera flash, butunfortunately

the author has been delayed in getting thisto me. [ hope you enjoy this months offings.

Photographing the sun - Peter Maunder / James Allan

As a kid I remember focusing the rays ofthe sun onto unsuspecting ants walking in
a line across the concrete. A little whiff of smoke redolent of formic acid would
indicate ignition. At the end ofthe affernoon the kid next door and I would have to
scrub the black marks offthe concrete, It is not surprising
that the same thing happens to the back of our eye when we
look at the sun. The focussed rays oflight burn a hole in the
retina at the back ofthe eye. Un fortunately the damage is
done to the very sensitive macular, the part ofthe retina with
which we read and identify faces etc. Without the macular we
would have only low resolution peripheral vision. In 1970
140 cases of solar retinopathy were reported in USA during
an eclipse ofthe sun. It’s not only aproblem for our eyes, but
also to our cameras if we want to take photographs of the sun.
On 6th of June this year Venus travelled across the face of
the sun, starting around 8am and finishing around 2.30. The
so called transit of Venus was first observed by William Crab- [
tree in 1639. The transit occurs in a weird cycle. There are
two transits 8 years apart ©ollowed by a gap of 105.5 years,

Continued page 5

Contacting amember from the club; This month Mark & Jenny
Pedlar :mnjpedlar@bigpond.com

AUGUST
2.Workshop: How to make an
Audio Visual

16. Competition: Water with
movement

Both water and motion

30. Guest Speaker: Antarctica
A guest speaker will present the
story of'their visit to the frozen
continent.

Notes:

SEPTEMBER

13. Annual General Meeting
Elect your committee! All posi-
tions are open!

This will be ©llowed by the
Disposable Camera Competition
Note: Bring a plate.

27. Competition : Low Light
These images must be taken
using only the light available at
the scene. The fact that light was
limiting must be obvious.

Note: Start preparing entries for
Annual Exhibition — forms avail-
able (physcially and online)

OCTOBER

29-Sep to 1-Oct. Labour Day
Weekend—Outing—Robe
stay away overnight event

11. BPC Images Quiz Night
Images captured by club mem-
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Picture Gallery—Photography as Art

Images taken by Club

M embers that I would be
happy to hangas art. Per-
haps the reason I chose
these images is for the
power with which the pho-
tograph transforms every-
day objects into something
else.

Yvonne Sears—Anna—
This is such an unusual por-
trait with the alternating
bands of dark and light
Matt Carr—Pipework—A
wonderful geometric design
reminiscent of a M ondrian
abstract

Chris Schultz—Frosty

M orning—beautiful tex-
tures in the ice crystals.
Macro photography really
takes us into another world.
Jo Tabe—Birtch tree—the
fish eye lens creates a won-
derful distortion

John Vidgeon—Bird in
wood—a very clever mon-
tage of a bird onto a tex-
tured wooden surface
Carolyn Becket—
Rainforest Conservatory—
Great use of angled lines
and simple compositional
elements to tell a different
story

Hillary Fran—Port Ade-
laide Lighthouse—an ice
crystal like kaleidoscope
treatment transforms this
familiar landmark into a
very intricate abstract.




Photoshop—Rectifying an Image James Allan

I was walking along Jetty road in Glenelg when I spied the Glenelg Congregational
church. From the opposite footpath the view was obscured by trams, traffic, parked
cars, street trees and wires. The only place from which I could get an uncluttered
view was standing on the same side of the street. From this side of the street the
church towers above me, the lines converging to a vanishing point almost directly
above me. With a wide angle lens I can capture the view but the church is distorted
by perspective. It looks like the church is leaning backwards. A tilt shift lens is a
wonderful thing. By tilting the lens you can straighten the vertical perspective and
give the illusion of standing 100 yards away from the building. Unfortunately ,
unlike Ray Goulter, I don’t have a tilt shiff lens.

Jeremy Watson however at his recent meeting told us that you can straighten the im-

age in photoshop. This article describes how it is done:

1. Display a grid. I find the grid very useful to show me the true verticals and
horizontals in the picture. Go to the View menu and scroll down the dialogue
to “Show” and within the show dialogue select Grid. When I first displayed
the grid, the lines were so close together I could no longer see the detail in the
picture. This can be easily fixed. You have to go to the Edit menu and select
the last item, “Preferences” and from that dialogue select “ Guides, Grid &
Slices ....”. Inthe window that appears I changed the “ Gridline every:” box to
200 pixels. That seemed to work OK for the 18Mpx images that I was work-
ing with.

2. Duplicate the background layer. This is necessary as Photoshop
does not let you use transform tools on the background layer. Ifyou
have the layers palette on view, you can right click on the back-
ground layer and select “duplicate layer” from the context sensitive
menu. Alternatively you can go to the Layer menu and select
“Duplicate Layer”

3. Skew the image. With the duplicated layer selected go to the Edit
menu and select the “Transform” dialogue and select “Skew”. A
dark line will appear around the image with 8 handles (small
squares) at the corners and midpoints of the rectangle. I move the 4
comer handles, one at a time so that I can line up the top and sides of
the building with the grid lines. This may take a bit of practice, but
it should be possibleto get all 4 sides of the building perfectly
aligned to the grid. Don’t worry too much ifthe building is rendered
too fat or too skinny. We will correct that later. When the building
is aligned accept the changes by clicking on the “tick “ above and to
the right in the options bar (just under the menu tool bar )

4. Free Transform the Image to correct aspect ratio of the building.

There is a free trans form icon in the tool palatte, orit can be accessed through
the Edit menu as follows: Edit /Transform / Free Transform. The same black-
line and 8 handles appear about the object, however they behave di fierently.
This time I grab the midpoint handle at the top and stretch to make the image
taller. I stretch until it looks roughly correct. Again I click on the tick at the
top right to accept the changes.

5. Dealing with gaps. In this transformation I have created a triangular gap on
either side ofthe church at the bottom ofthe image. From a distance these are
not too obvious as the underlying layer matches and gives a clone like fill for
the gap. However if you wish to hide the gap you have two options. You can
either crop the image or use the clone tool to create a convincing cover.
Sometimes you could do both.

6. Use the “save as” command and give the image a new title. Do not use
“save” command as you will lose the original image.
7. Don’t tell your viewers what you have done to the image. Photoshop is a bit

like a magic trick. Once you explain the trick to the viewer, they lose that spe-
cial fondness for the image. Tell them that you have a very fine camera that
takes great shots.
I have also used this technique to straighten stained glass windows and art works
hanging on walls. Sometimes I might decide to only rectify the image halfway in
order to give a sense of realism while removing the worst of the distortion. Feel free
to give ita go. You can always phone me if you get stuck.




Chromatic Aberration — James Allan

There are many ways to get a bad image. Poor contrast, lack of focus, colour cast,
lens flare, noise. Another to add to the list is chromatic aberration. It is some-
times referred to as purple fringing. It tendsto occur wherethe con- |
trast is highest, often worst at the comersof the image, especially
when the image is enlarged I didn’t haveto look far to find an ex-
ample. In this picturetaken at Jupiter creek in 2004 youcan see that
the dark limbs have a purple edge on one side and a green edge on
the opposite. The problem arises as different colours are bent to
different degrees by the glass of the lens. The same effect that
causes arainbowto be created by a prism. You will notethe
marked chromatic aberration in my transit of Venus photo
(Photoclips banner). There are two main manifestations. One isthe
purple fringing mentioned above where there is a lateral displace-
ment of the image i each of the differing colowrs. This can be cor-
rected by post processing to realign the different colours. The other [
is a vertical displacement (aboveor belowthe image plane) of the
different colours resulting in overall blurring and inability to get a
sharp image. This cannot be corrected and causes problems even if youuse black
and white film.

Sir Isaac Newton realised that he could reduce this phenomenon by using lenses
with long focal lengths. Asaresult he was able to build the first telescopes and
microscopes that were able to give sharp images at great magnification. (This is
why telescopes are so long). Subsequent lens manufacturers have gone to a lot of
trouble to minimise this chromatic effect. Glass that contains fluorite often has
less of a chromatic effect than other glasses. Another technique is to usemulti-
component lenses. If two types of glass, with different chromatic properties
(crown glass and flint glass) are usedto create a lens element, then the red and
blue ends of the spectrum can be bent to similar degrees. This set up is called a
doublet. In such alens one element must be a divergent lens, eventhoughthe
overall effect will be to converge the light rays. Another altemative isto use a
curved mirror to create the image, as there is no chromatic effect with reflection.

Some digital cameras (Nikon, Panasonic) have algorithms inthe camera that will
correct the lateral chromatic shift according to theknown properties ofthe lens.
Thistakes place before the data is written onthe card. There is also post produc-
tion software that will do the same thing, reading the lens data imbedded in the
file. The Nikon and Cannon software will do this, and there is athird party prod-
uct PTLens.

In photoshop there are a couple of sliders that allow you to adjust red/cyan and
blue /yellowfringing. (Filter/Distort/Lens correction) I usedthese sliders on my
image above, but | was unableto create a satisfactory result. Part ofthe problem
is that we are now dealing with rgb channels whereas the original problem was
created by the separation of light accordingto frequency. (a subtle but important
difference) Other fringing solutions I have seen mclude—desaturation, selection
ofthe fringe colour then colour adjustment and as a last resort cloning . None of
these are ideal.

In summary—chromatic aberration is created by the lenses in the camera. Better
quality lenses have less effect. When youare buying equipment it is important to
look for chromatic aberration as it is a hallmark of a poorer quality product. Soft-
ware canhelp, however it is better not to rely on software to correct a problem in
the lens.
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Photographing the sun - Peter Maunder / James Allan J

From page 1

another 2 transits 8 years apart and then another gap of 121.5 years.
(this is remarkably less common that a lunar eclipse of the sun, which will occur an-
other 4 times this decade) I recall from primary school history lessons that Captain
Cook travelled to the South Pacific (T ahiti) explicitly to observe and time the transit
of Venus. The Royal Society had commissioned the journey, so that the distance of
the earth from the sun could be calculated. It appears that the transit of Venus in a
historical sense has special significance to us Australians. Accordingly I was keen to
observe and ifpossible photograph the phenomenon.

I tried to build a pinhole camera, which disappointingly gave very poor resolution. I
suspect that the hole was not regular and perhaps too large. My second attempt was
with a cardboard box and a pair of binoculars. I focussed the suns rays on the bottom
of'the box in the same way that I had focussed the sun’s rays onto ants. I placed a
piece ofwhite paper on the bottom of my box. To the right is an image of the ap-
pearance inside the box, showing the sun and the branches from the trees. Amazingly
I got a clear image that I was able to photograph. When the clouds eventually cleared
at around 11am I was able to watch the transit until it finished at around 2.30. You
can see my image at the top of this newsletter—displayed as the banner. Ofcourse it
is not a very sharp image due to chromatic aberration in the binoculars.

At the next club meeting I was surprised to discover that one of our members, Peter
Mauder has also photographed the transit. Peter photographed the transit through his
telescope 8 years previously. He protected the optics of the telescope and camera
using Baader Film. T will let Peter tell the rest of the story:

The Baader film is a safety film for solar observation. It is made for the construction
of high-quality objective-filters for observing the sun with telescopes, binoculars,
camera or video-lenses. This foil is CE-tested and reduces the intensity of sunlight by
99.999% (optical density 5.0). The image of the sun is extremely contrasty and of al-
most neutral colour.

This film is cheap and easily available and is mounted on the telescope or camera
“objective lens”. The film goes right at the front of the telescope between the sun and
this first lens. It is a very safe method, as the light reduction occurs before any optics,
which will magnify the suns energy. On the other hand if the sun filter is placed after
the prime/objective lens it might heat up, burn and crack suddenly. If this happens
the macular and hence the eye can be destroyed in a fraction of second.

As can be seen by my images the Baader Film produces a rather flat uninteresting
view of the sun because it merely reduces light intensity at all wavelengths.

The second of my images, at greater magnification shows the “teardrop” effect as the
planet appears to merge with the edge of the suns disc. (This phenomenon caused
Captain Cook particular problems in deciding when the transit had started and fin-
ished. Despite these problems the 1770 calculation of the distance to the sun was
remarkably accurate.)

A better method, but substantially more expensive, is to use a dedicated solar tele-
scope as has Paul Haese, a fellow member of ASSA (Astronomical Society of SA).
This method uses a narrow bandwidth filter at 0.5 angstroms wavelength, to highlight
the interesting parts of the visible spectrum.

The following image from Paul Haese could be copyrighted and so should not be
widely distributed— I have Paul’s permission for publishing it in the newsletter pro-
viding it is published with acknowledgements to Paul Haese.

Cropped selection from image by Paul Haaese using a dedicated solar telescope with
0.5angstrom narrow bandwidth filter

Binoculars and card-
board Box setup

View inside the box

Baader film

Telescope—38 inch F4 Optex Newtonian
Reflector. Focal length 800mm: eyepiece
25mmwith Baader film—
Camera—Kodak 6340 Digital Camera us-
ing eyepiece projection

T eardrop effect




Aesthetics—(Isthat art?)-in a single page James Allan

The Philosopher Socrates would ask a young novice to describe the attrib-
utes of beauty. Once he had drawn out and clarified a logical answer from
the novice, to their utter frustration, he would then quote endless examples
of beautiful objects that stood outside their definition and ugly objects that
stood within. It was a standard philosophical party trick that eventually
lead to questions like—"what is art?” and the whole field of aesthetics.
There is a relativist answer to this conundrum that suggests beauty or art is
not a set of criteria but a group of objectsthat I have selected. This makes
sense, and explains the fact that different people have different tastes in art.
However it’s not enough. You could ask why it is that some objects are
almost universally seen as attractive? Why can we sell a Van Gough for
millions? What is it that gives it worth? Kant suggested that universal va-
lidity occurs because we are all human. He argues that our appreciation of
art is not dictated by our education but is intuitive. Inthe 19th centaury the
art academies prescribed exact formulationsto describe art in terms of line,
form, texture, composition, theme, tone and colour. At the time this was
almost universally accepted. Inthe early 20th centaury however each of
these precepts were abandoned by successive movements of art. We are
familiar with the impressionists, the expressionists, cubists, abstract art,
Dadaists and so forth. Currentlythere are no preceptsthat can be used to
describe the attributes of art other than that it is recognised by the public as
being art. As one artist expressed it—"Well if it isn’t art, What the hell is it
doing in an art gallery and why are people comingto look at it?” (Tracey
Emin) She was making the point that perhaps art is deemed as art by the
experts. Perhaps we’ve asked that same question more in the sense of—
”Blow the experts—how much did they pay for that rubbish.”

The purpose for this discussion is to ask the question, “ Is photography art?”
Some would say that it is merely a slavish reproduction of reality and shows
no creative genius. The other day I was interestedto hear the opposing
point of view from a historian. He argued that you could not take photo-
graphs as evidence of historic events asthey are crafted by the photographer
to deceive us to see what he intends us to see. Susan Sontag wrote a book,
“on photography” where she discusses these questions. She observes that
photography which was initially a very restricted pursuit, has become avail-
able to the masses through the box brownie, the instamatic camera and
more recently the compact point and shoot. There has been such a prolif-
eration of photographsthat they now outnumber all other images on the
planet. Susan argues that such a proliferation of images changes the bal-
ance of political power. It could be noted that they are not all good images.
There are some very skilled craftsmen producing superior images. Ansel
Adams takes the view that “You don’t take a photograph, you make it”.
This suggests that photography is an art form, at least for Ansell Adams.
But are some photographers artists while others merely take photos? Isthe
intention of the photographer important? This can’t be true as there are ob-
vious exceptions on each side of the argument. Some very poor photos
were intentioned as art and some good ones were not. Rather than ask the
question—"Is it art?”, perhaps we should ask, —”Is it good art?”

“Ithink that's what art is: art is communica-
tion made in the hope that interesting mis-
communications will arise.” — Misha
Glouberman

Immanuel Kant

Art is an invention of aesthetics, which in
turn is an invention of philosophers....
What we call art is a game. - Octavio Pez

Susan Sontag

“Rules oftaste enforce structures of
power.” — Susan Sontag



